RS Automation, Inc.
Modbus Modicon F50

Supported version TOP Design Studio V1.4.3 or higher {Rl

CONTENTS

We would like to thank our customers for using M2l's "Touch

Operation Panel (M2 TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device”.

1. System configuration Page 2

Describes the devices required for connection, the setting of

each device, cables, and configurable systems.

2. External device selection Page 3

Select a TOP model and an external device.

3. TOP communication setting Page 4

Describes how to set the TOP communication.

4. External device setting Page 9

Describes how to set up communication for external devices.

5. cable table Page 10

Describes the cable specifications required for connection.

6. Supported addresses Page 13

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration

The system configuration of TOP and “RS Automation, Inc. — Modbus Modicon F50" is as follows:

Communication .
System setting

Series ‘ CPU ‘ Link I/F ‘

method

3. TOP communication
RS-232C setting 5.1. Cable table 1
4. External device setting

3. TOP communication
RS-422(4 wire) setting 5.2. Cable table 2
4. External device setting

RS Automation Modbus Modicon F50

3. TOP communication

settin
RS-485 (2 wire) sy 5.3. Cable table 3

4. External device

setting

W Connection configuration

+ 1:1 (one TOP and one external device) connection — configuration which is possible in RS232C/422/485 communication.

+ 1:N (one TOP and multiple external devices) connection — configuration which is possible in RS422/485 communication.

) (] S—

[J ' ji«?' ?:"] .........
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device H
PLC select [COM1]

Filter : |[AII] v‘ Search : I:I

@ Model (O Vendor

Vendor Model

e A
Rockwell Automation & N Series
GE F. Automa ti

anue Automaten & NX Plus Series
PANASONIC Electric Works

XB Series
YASKAWA Electric Corporation
(@ SPC Series

YOKOGAWA Electric Corporation 75
" Modbus Madicon F50
Schneider Electric Industries

KDT Systems

HITACHI IES

FATEK Automation Corporation
DELTA Electronics

KOYO Electronic Industries

VIGOR Electric Corporation

COMFTIF TECHNOI OGY Tnc &

4_Back | B Next *® Cancel

Select Device n

PLC Setting[ Modbus Modicon F50 ]

Alizs Mame @ |PLCL

Interface : | Serial ~

Protocol : | MODBUS RTU ~ Comm Manual
String Save Mode : |First LH HL Change

[ use Redundancy

AND ~
Condition - Edi
Primary Option
Timeout msec
Send Wait msec
Slave ID DI
@ Back + OK * Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.
Select “RS Automation”.
PLC Select an external device to connect to TOP.

Interface Protocol

Modbus Modicon F50 Serial MODBUS RTU

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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3. TOP communication setting

TO,

ERI2 e B X
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [Project > Project Property > TOP Setting] — [Project Option > “Use HMI Setup” Check > Edit > Serial]

— Set the TOP communication interface in TOP Design Studio.

Project Opticn

-Change HMILH]

B Ao ric ST Change PLCIO)

t D TOP Setting l
o H 520K

.15 COM3 (0)
-4 Ethernet (0)
Wireless (0)
-4 USBDevice {0)

Date / Time Sync.  Screen Option

HmiSetup

E3 Delete PO

Unit Convert

Global Lock & Touch Project Style  Splash

Initialization | Edit |

PLC Buffer Sync.

~ -l Option Module Setting Project Option  Screen Change
- FieldBus (0)
-y RFID (0) Use HMI Setup
~ i@ Device Setting
v 158 COM1 (1) D
i - PLCL: Modbus Modicon F Project Setting
-1gM COM2 (0) HMIDisable=0

Project Name=New project
Start Mode=Menu

Start Screen No.=1

Latch Use=0

Latch Set=0~0

Communication Error Message =0
USBErrorMessage=0
StorageErrorMessage=1
DatabaseMessage=1

~

Control Panel

System m Devices

:naService _'4"'_' Option

R——
il

PLLC

o

SECUrity Oat e/Time

EE]

Serial Port: @ COM1 <
Siagnal Level

(®) R5-232C () R5-4220(4) () R5-4586(2)

_ Baud Rate: 38400 -
o o —
% o el el ) _
I Data Bit: 8 -
Ethernet Serial HOM | Stop Bit: 1 -
S \ Parity Bit: MNaone =
= ""\\ Flow: [ff
L | . Ping
Diagnost ic File Ping Auto Search Lﬂopbﬂck Test
Manager
Apply | Cancel
Items TOP External device Remarks
RS-232C RS-232C
Signal Level (port) RS-422 RS-422
RS-485 RS-485
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

W [Project > Project Property > Device Setting > COM > “"PLC1: Modbus modicon F50"]

— Set the options of the Modbus modicon F50 communication driver in TOP Design Studio.

ERI2 e B X
Touch Qperation Panel

Project Option

- Change HMI[H] ' AddPLC[A] | TH[Ta) Change PLCIC] | [] Delete PLC[D]

~ ] TOP Setting

| L[ 5Y5:RD1520%
Option Module Setting
B FieldBus (0)

..... W RFID (0)

W gy Device Setting

™ Wireless (0)
8 USBDevice (0)

PLC Setting[ Modbus Modicon F50 ]
Alias Name : [PLC1 |

Interface : | Serial ~

Protocol : |MODBUS RTU ~
String Save Mode : (First LH HL Change

[ use Redundancy

Primary Option

Timeout msec

Comm Manual

Send Wait msec
Slave ID I:I
< >
Apply Close
Items Settings Remarks
Interface Select “Serial”. Refer to “2. External
Protocol Select “"MODBUS RTU". device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device

and sending the next command request.

Slave ID

Enter the prefix of an external device.
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3.2. Communication setting in TOP

TO,

ERI2 e B X
Touch Qperation Panel

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [Main Screen > Control Panel > Serial]

®

Conitroll Panel

Serial

Serial Port: lCDhﬂ

Siagnal Level

® R5-232C O RS-422(4) O RS-486(2)

Baud Rate: | 38400

¥YNC .
Yiewer [H-L.] } Data Bit: l 5 ‘
o 0
PEmEyg "I"" Stop Bit: l 1 "
[ ] Et hernet Serial
' Parity Bit: | None -
Emm A e
Screen _% Flow: l Off ‘v
shot h
[Auto Searchl [Loopback Test]
Diagnost ic File
Mariager
[ Apply H Cancel ] I—
[System] Close r
Items TOP External device Remarks
RS-232C RS-232C
Signal Level (port) RS-422 RS-422
RS-485 RS-485
Baud Rate 38400
Data Bit 8
Stop Bit 1
Parity Bit None.

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting
M [Main Screen > Control Panel > PLC]

Bun

o)

PLC

i

Ethernet

™

Diagnost ic

[System]

Driver(COM1)

TO,

PLCT(Mocbus Medicon F50) ~|

Interface | Serial Rd
Protocol | MODBUS RTU Rd
Timeout 300 15 msec
Send Wait MmSec
Retry
slave |D =

Diagnostic

ERI2 e B X
Touch Qperation Panel

-‘6 Juil] PLE

@ System

| 4eply || Cancel |

|

Items Settings Remarks
Interface Select “Serial”. Refer to "2. External
Protocol Select “"MODBUS RTU". device selection”.

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP’s receiving a response from an external device

and sending the next command request.

Slave ID

Enter the prefix of an external device.
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
' . ) 1. System configuration
configuration Connection cable name oK NG
TOP Version information oK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) oK NG . .
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name oK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings OK NG . .
4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
oK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Configure the communication settings of the external device by referring to the vendor’s user manual.
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5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.

(The cable diagram described in this section may differ from the recommendations of “RS Automation.”)

5.1 Cable table 1

M 1:1 connection (RS-2320C)
TOP COM Port (9 pin)

COM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
1 5 CcDh 1
(@ o) RD 2 SD
Q ) ) 3 RD
4 9 DTR 4 DTR
Based on —
L SG 5 SG
communication -
DSR 6 DSR
cable connector It
f RTS 7 RTS
ront, =
D-SUB 9 Pin male c1s 8 | CcTs
(male, convex) 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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5.2. Cable table 2
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M 1:1 connection (RS-422)

TOP COM Port (9 pin)

CcCoM PLC
Pin Signal Pin Cable connection Signal
arrangement*Note 1) name number name
1 5 RDA 1 SDA
(© o) 2 SDB
o s} 3 RDA
6 9 RDB 4 RDB
Based on
. SG 5 SG
communication
SDA 6
cable connector
front, 7
D-SUB 9 Pin male 8
(male, convex) SDB 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

B 1:N connection — Refer to 1:1 connection to connect in the following way.

Cable connection and signal

direction

PLC

Signal name

SDA

SDB

RDA

TOP Cable connection and signal PLC
Signal name direction Signal name
RDA SDA
RDB SDB
SDA RDA
SDB RDB
SG SG

RDB

SG
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5.3 Cable table 3

M 1:1 connection (RS-485)
TOP COM Port (9 pin)

CoOM PLC
Pin Signal Pin Cable connection Signal
arrangementNote 1) name number name
1 5 RDA 1 SDA
Q o 2 *—1 SDB
Q o) 3 RDA
6 9
RDB 4 —® e— RDB
Based on
. SG 5 SG
communication
SDA 6
cable connector
front, !
D-SUB 9 Pin male 8
(male, convex) SDB 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

B 1:N connection — Refer to 1:1 connection to connect in the following way.

TOP Cable connection and signal PLC Cable connection and signal PLC
Signal name direction Signal name direction Signal name
RDA SDA SDA
RDB SDB SDB
SDA — *~— RDA — RDA
SDB RDB RDB
SG SG SG
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6. Supported addresses
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

Bit Address Word Address R/W Remarks

uo 0001.00 ~0017.15 0001 ~0017 R Inverter operation status

U1 0101.00~0115.15 0101~ 0115 R Operation status in case of abnormality

U2 9920, 9922, 9924, 9926 9920, 9922, 9924, 9926 R/W Abnormality history

U3 N/A N/A Constant test record, communication does not allow R/W

BO 1001 .00~ 1014.15 1001 ~ 1014 R/W Operation basic settings

B1 1101.00 ~ 1103.15 1101 ~ 1103 R/W System initialization

B2 1201 .00~ 1203.15 1201 ~ 1203 R/W Capacity, control mode setting

FO 2001 .00~ 2009.15 2001 ~ 2009 R/W Frequency Command

F1 2101 .00~ 2110.15 2101 ~2110 R/W Frequency Command Range Limit

F2 2201 .00~ 2206.15 2201 ~ 2206 R/W Acceleration/deceleration time

F3 2301.00 ~ 2304.15 2301 ~ 2304 R/W S Acceleration/deceleration time

F4 2401 .00~ 2016.15 2401 ~2016 R/W Pattern operation setting

S0 3001 .00~ 3004.15 3001 ~ 3004 R/W Direct brake function

S1 3101.00~ 3104.15 3101 ~ 3104 R/W Speed search function

S2 3201.00 ~ 3204.15 3201 ~ 3204 RW Dwell operation

S3 3301 .00~ 3304.15 3301 ~ 3304 R/W Energy saving operation

S4 3401.00 ~ 3403.15 3401 ~ 3403 R/W Slip correction

S5 3501.00 ~ 3502.15 3501 ~ 3502 R/W Torque correction

S6 3601.00 ~ 3603.15 3601 ~ 3603 R/W System error correction

S7 3701.00 ~ 3721.15 3701 ~ 3721 R/W PID operation settings

Co 4001.00 ~ 4008.15 4001 ~ 4008 RW VI/F settings

C1 4101.00 ~4105.15 4101 ~ 4105 R/W Modification method

C2 4201.00 ~4208.15 4201 ~ 4208 R/W Motor constant

C3 4301.00 ~4310.15 4301 ~4310 R/W H/W adjustment constant

HO 5001.00 ~ 5007.15 5001 ~ 5007 R/W Multifunction Input Contact

H1 5101 .00~ 5106.15 5101 ~ 5106 R/W Multifunction Output Contact

H2 5201.00 ~5213.15 5201 ~ 5213 R/W Multifunction Analog, pulse train input

H3 5301 .00~ 5306.15 5301 ~ 5306 R/W Multifunction Analog, pulse train output

H4 5401.00 ~ 5406.15 5401 ~ 5406 R/W Digital Operator settings

PO 6001.00 ~ 6003.15 6001 ~ 6003 R/W Motor protection function

P1 6101.00 ~6106.15 6101 ~ 6106 RW Immediate power outage function

P2 6201 .00~ 6206.15 6201 ~ 6206 R/W Stall prevention

P3 6301.00 ~ 6303.15 6301 ~ 6303 R/W Excess torque detection

P4 6401.00 ~ 6402.15 6401 ~ 6402 R/W Abnormal retry setting

P5 6501.15 6501 R/W Fan Inspection Status

P6 6601.15 6601 R/W PID constant

EU 9900.00 ~9901.15 9900 ~ 9901 R Show error notation

SuU 9500.15 9500 RW Device function status notation
FreQ | 9501.15 9501 R/W Communication frequency command
Reset | 9910.15 9910 W Clear fault
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